
  How to use the Footnote Manipulator plugin


  Introduction


  The Footnote Manipulator inserts footnotes in epubs. It will append footnotes for each xhtml section at the end of the xhtml section in which they occur; alternatively it will place all the footnotes in one xhtml section. A number of options are provided to customise the way the footnotes are produced.


  Text for each footnote is included in the xhtml file at the place where the hyperlink to the footnote is required. This text must be marked by a specific span tag (discussed later). When the plugin runs, it looks for marked text, moves it to produce a footnote and inserts a hyperlink to the footnote.


  This version of the plugin will work only with Sigil version 0.9.0 and above.


  Screenshots for this ebook were taken in Windows 10; the plugin may appear to be slightly different with other operating systems.


  Features


  The current version of this tool has the following features:


  	Footnotes can be placed at the end of each xhtml section or all the footnotes can be placed together in one xhtml section;



  	All hyperlinks to the footnotes are numbered automatically in the form 1, 2, 3, etc. Text may be included for each numbered hyperlink (eg 'Note 1') and/or brackets can be placed around the hyperlink (eg [1]). In each of these examples the number is inserted automatically and is incremented for each separate footnote;



  	The hyperlink for each footnote can be set up as a superscript if required;



  	The hyperlink (backlink) in the footnote itself that takes the reader back to the main text may include a number that is incremented automatically in each footnote or text may be placed in the footnote without a number (eg 'Back'). Alternatively, both an automatically incremented number and specified text may be included in the backlink;



  	The hyperlink in the footnote itself that takes the reader back to the main text may be placed at either the start or the end of the footnote;



  	A css file to format the footnotes may be specified and this is imported into the ePub when the plugin runs. The sample css file in the manual also formats the text that is to be hyperlinked; this distinguishes the text for the footnote from that of the main text;



  	The settings for the plugin may be saved so that they may be used with other ePubs;



  	Footnotes can be moved back into the body of the text in the appropriate xhtml section; this is useful if it becomes necessary to add more footnotes later or delete some of the existing footnotes. Then, when the plugin is run to reinsert the footnotes, the notes will be inserted with updated numbers in the correct sequence;



  	Footnotes in ePub 3 eBooks may include epub:type="footnote" in footnotes and epub:type="noteref" in hyperlinks to the footnote;


	Pop-up footnotes have been implemented using the ‹aside› element


  	Advanced users can specify the names for classes, hyperlinks and IDs that are associated with footnotes.



  


  


  Warning


  Make sure that you have a backup of your ePub file before running this plugin.


  Licence and copyright


  Copyright (c) 2024 John Crew.


  All rights reserved.


  Redistribution and use in source and binary forms, with or without modification,
for commercial and non-commercial purposes are permitted provided that the
following conditions are met:


  1. Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer.


  2. Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation and/or
other materials provided with the distribution.


  3. Neither the name of the copyright holder nor contributors may be used to endorse or promote products derived from this software.


  4. The source code for this plugin must be made available to users of this plugin.


  5. Plugins or any other software that is derived from the source code for this plugin may be distributed to other users provided that the derived source code is made available to those users.


  THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.


  Installation

Remove the previous version of this plugin


  If you have a previous version of this plugin installed on your computer then it is recommended that you delete the old files for it  as follows:

1. Select Preferences from the Edit menu in Sigil.

2. Click Open preferences location.

3. Open the folder plugins_prefs and delete the folder FootnoteManipulator and all its contents.

4. Also delete the the folder FootnoteManipulator and all its contents from the plugins folder.

Install the latest version of this plugin


  1. Open Sigil and select Manage plugins from the Plugins menu.


  2. Click Add plugins to open the to view the Select Plugin Zip Archive window.


  3. Navigate to the location of the plugin zip file named FootnoteManipulator and select this zip file.

4. Click the button labelled Open to install the zip file.

5. To install the icon for this plugin in the toolbar in Sigil select the plugin in one of the dropdown boxes at the bottom of the plugin window.


  4. Click the button labelled OK.


  Using the FootnoteManipulator plugin


  Introduction


  The FootnoteManipulator plugin requires two step:


  1. 'Marking up' text for the footnote.


  2. Running the plugin to insert the footnotes.


  Marking text to include in a footnote


  Type the text for each footnote into the body of the text at the point where the link to the footnote is required. Precede this text with the tag <span class="FNOTE"> and put the closing tag </span> at the end of the text for the footnote. The plugin will detect these 'markers' and move the text that is between them to a footnote when the plugin runs.


  Here is an example in code view that shows a paragraph in which two pieces of text have been marked as footnotes:


  <p>Lorem ipsum dolor sit amet, <span class="FNOTE">This is a footnote</span> consectetur adipiscing elit. Nulla ac tellus nunc. Phasellus imperdiet leo metus, et gravida lacus. Donec metus ligula, elementum at pellentesque pellentesque, suscipit ac nunc. <span class="FNOTE">This is another footnote</span>Etiam lobortis, massa ac aliquam auctor, augue nisl sagittis urna, at dapibus tellus erat ullamcorper ligula. Praesent orci dui, pulvinar id convallis a, faucibus non mauris.</p>


  The class FNOTE could be styled using a css file so that text for the footnote can be distinguished from the main text. The following example shows the above paragraph could appear in bookview (or PageEdit) with appropriate styling in a css file. The style causes the text for the footnote to be highlighted in yellow and is a different font.


  Lorem ipsum dolor sit amet, This is a footnote consectetur adipiscing elit. Nulla ac tellus nunc. Phasellus imperdiet leo metus, et gravida lacus. Donec metus ligula, elementum at pellentesque pellentesque, suscipit ac nunc. This is another footnote Etiam lobortis, massa ac aliquam auctor, augue nisl sagittis urna, at dapibus tellus erat ullamcorper ligula. Praesent orci dui, pulvinar id convallis a, faucibus non mauris.


  When the footnote is moved to its final location (eg at the end of the xhtml file) this styling will not be applied. A different style may be used for the footnote if required.


  Running the plugin to insert text marked up as a footnote


  From the Plugins menu in Sigil select Edit followed by FootnoteManipulator.


  A window will open showing the settings that are available.


  [image: MainWindow]


  Adjust the settings as follows:


  1. Footnotes - Location and numbering


  1.1 Location of footnotes


  To put the footnotes at the end of the xhtml section in which they occur click the button labelled Current html section. Alternatively to put all the footnotes in one section click the button labelled New xhtml section.


  1.2 Numbering for hyperlinks


  If Current html section is chosen then the option of restarting the numbering of the footnotes in each xhtml section at 1 becomes available. To restart the numbering of the footnotes in each xhtml section at 1 tick the box labelled Restart numbering for each xhtml section.


  2. Setting up the hyperlinks


  2.1 Making the hyperlink a superscript


  To make the hyperlink to each footnote a superscript tick the box labelled Make the link a superscript.


  2.2 Text for the hyperlink


  Each hyperlink to its footnote will include a number. Text may be placed around this number that is displayed in the main body of the text as follows:


  Enter text to be inserted in front of the number in the box labelled Prefix for hyperlink.


  Enter text to be inserted after the number in the box labelled Suffix for hyperlink.


  For example, if you put [ in the box labelled Prefix for hyperlink and ] in the box labelled Suffix for hyperlink then the number will be placed in square brackets: [xxx] (where xxx is a number that is generated automatically by the plugin).


  Another example: if you put [Note in the box labelled Prefix for hyperlink and ] in the box labelled Suffix for hyperlink then the number will be placed in square brackets with the word Note preceding the number: [Notexxx] (where xxx is a number that is generated automatically by the plugin).


  3. Setting up the backlinks


  The backlinks are the hyperlinks in the footnote that take the reader back to the main body of the text when they are clicked.


  3.1 Position of backlinks


  To put the backlink at the end of the footnote tick the box labelled Put the link at the end of the footnote.


  3.2 Numbering backlinks


  Tick the box labelled Include a number in the footnote if each backlink is to include a number that is generated automatically by the plugin. Text may be placed around this number as follows:


  Text for backlinks


  Enter text to be inserted in front of the number in the box labelled Prefix for backlink.


  Enter text to be inserted after the number in the box labelled Suffix for backlink.


  If an automatically generated number is not used in the footnote, then entering text in either the box labelled Prefix for backlink or the box labelled Suffix for backlink will produce a backlink that contains only that text.


  WARNING: If automatic numbering for the backlink is not required then text must be entered into at least one of the boxes mentioned above otherwise backlinks will not be available. 


  4. Inserting a css file to format the footers


  An external css file may be imported by this plugin to format the footnotes. A sample file has been provided in Appendix 1 to demonstrate this plugin. This uses the default values of the classes, hyperlinks and IDs that are associated with footnotes.


  To select a css file click the button with ellipsis on it (...) to view the Open CSS file window:


  [image: FileDlg]


  Navigate to the required css file and click Open. The plugin window will show the selected file and its path in the box labelled CSS file.


  5. Saving the settings


  Save the settings by clicking the button labelled Save settings.


  6. Advanced options


  The plugin includes some advanced options that will enable you to specify the names for classes, hyperlinks and IDs that are associated with footnotes. You can also include the epub:type="footnote" in footnotes and epub:type="noteref" in hyperlinks in your footnotes.


  It is recommended that you gain experience with the main settings before using Advanced options. Incorrect use of Advanced options when reinstating footnotes can destroy your epub.


  Click the button marked Advanced to access the Advanced options. This opens the window shown:


  
   




  [image: AdvancedDialog]


  
   




  The diagram shows the default settings for the options available.


  1. The name of the css section


  If you put all your footnotes in one xhtml section then the name for this section can be specified in the box labelled Enter name for xhtml footnote section. The default value is Footnotes.


  2. Footnote heading


  If you want to put  headings above your footnotes then type the heading into the box labelled Enter heading for footnotes. The default value is FOOTNOTES.


  If you do not want a footnote heading then leave this box blank.


  3. The class name for the footnote heading


  You can enter the class name for the footnote heading by typing a name in the box labelled Enter class name for footnote heading. The default value is Footer.


  4. ID for each footnote


  All footnotes have the same ID followed by an automatically generated number. You can enter an ID for the footnotes by typing the name for the ID in the box labelled Enter ID for footnote. The default value is FNID.


  5. Class name for each footnote


  All footnotes have the same class name. You can enter a class name for the footnotes by typing a name in the box labelled Enter class name for footnote. The default value is Footnote.


  6. ID for each hyperlink


  All hyperlinks have the same ID followed by an automatically generated number. You can enter an ID for the hyperlinks by typing the name for the ID in the box labelled Enter ID for hyperlink. The default value is FOOTNOTE.


  7. Class name for highlighting footnotes in the main body of the text


  All footnotes have the same class name in the main body of the text. You can enter a class name for highlighting footnotes in the main text by typing a name in the box labelled Enter name for highlight class.The default value is FNOTE.


  8. Include epub:type elements and pop-up footnotes


  Tick the box labelled Include ePub3 types? to  include epub:type="footnote" in footnotes and epub:type="noteref" in hyperlinks to the footnote. This option also implements pop-up footnotes. This only applies to ePub 3 books; it has no effect in ePub 2 books.


  Saving advanced options


  After setting up the advanced options, click the button labelled Save to save your changes. If you don't want to keep the changes, click Cancel (or press the Escape key) to cancel your changes.


  You will be returned to the main window for this plugin.


  9. Inserting footnotes in your ePub


  Insert footnotes using the selected settings by clicking the button labelled Insert footnotes. This action will also close the window for the plugin.


  Using the plugin to restore footnotes to the body of the text


  Introduction


  During editing/revisions of the ePub some footnotes may need to be removed and/or new footnotes may need to be inserted. Renumbering the footnotes manually can be a nightmare! The plugin automates this process. It will move the text for each footnote back into the body of the text at the appropriate point, inserting the tag <span class="FNOTE"> at the start of the text for each footnote and placing the tag </span> at the end of this text. Footnotes can then be deleted from the main text or new footnotes can be inserted before running the plugin again to insert all footnotes in the epub.


   The css file can include a format for text between these tags (eg yellow highlight) so that the text for footnotes can be clearly seen in Sigil or Page Editor. 


  How to restore footnotes


  1. Run the plugin.


  2. Adjust the settings so that they match the settings that were used when the footnotes were produced. This includes the Advanced options if you changed any of these.


  IMPORTANT: When moving the text for the footnotes back into the body of the main text it is vital that this step is carried out accurately. As the settings for the plugin can be combined in many different ways the plugin cannot verify that the settings do match the original ones.


  IF THE SETTINGS DO NOT MATCH THEN THE FOOTNOTES MAY NOT BE PLACED CORRECTLY IN THE BODY OF THE TEXT. For this reason, it is recommended that WORK BE CARRIED OUT ON  A COPY OF THE EPUB.


  3. Click the button labelled Reinstate footnotes. The text for each footnote will be inserted in the body of the text at the appropriate place and will be surrounded by the tags <span class="FNOTE"> and </span> and the footnotes themselves will be removed. If you used the Advanced options to change the class name for highlighting footnotes to something different to FNOTE then this will appear as the class name.


  Updates


  When you run the plugin it will check the web to find out whether an update is available. A message will be displayed in the Sigil Plugin runner window to let you know whether the installed plugin is current or whether an update is available (You need to click the Details button to see this information).


  If an update is available a window will open with three buttons:


  [image: UpdateFound]


  1. Go to webpage


  This will take you to the page at mobile read that provides a link for the updated plugin (and manual if appropriate). You will need to download the update to your computer and then install the plugin manually.


  2. Set time before checking for updates


  This opens another window labelled Set update timing that allows 

 (i) the time between checks for updates to be set (in hours) and

 (ii) reminders that an update is available to be set (in minutes).

The default values are 24 hours and 60 minutes respectively.


  [image: SetUpdates]


Click the button labelled Close to save any changes that you make to these times.


  3. Remind me later


  This option closes the reminder window and will remind you about the update later, using the times set in the window Set update timing.


  Installing updates


  Before installing an updated version of the plugin the older version must be uninstalled as follows:


  1. In Sigil, select Manage Plugins from the Plugins menu. This opens a window that shows a list of installed plugins.


  2. Click on the name of the plugin (FootnoteManipulator) to highlight it.


  3. Click Remove plugin


  4. Click OK.


  5. Install the updated plugin (see the section Installation above). Previous settings will be retained.


  Appendix 1: Sample css file


  This shows an example of a style for the footers; it also styles the FNOTE class


   



  .FNOTE {


  	font-family:"Courier New", Courier, monospace;


  	font-weight: bold;


  font-size: 0.8em;


  background-color: yellow


  }


   



  .Footnote {


  	font-size: 0.8em;


  }


   



  .Footer {


  	color: green;


  	font-size: 1.2em;


  	font-weight: bold;


  	text-align: center;


  	margin-top: 1.5em;


  	margin-bottom: 1.5em;


  	border-top: 1px solid black;


  	padding: 20px;


  }


Footnote example


The next two pages demonstrate the use of the Footnote Manipulator. The first page shows how to use a span tag to mark the text that is to appear as a footnote. The second pages shows the effect of running the Footnote Manipulator


Footnote sample

Lorem ipsum dolor sit amet, This is a footnote consectetur adipiscing elit. Nulla ac tellus nunc. Phasellus imperdiet leo metus, et gravida lacus. Donec metus ligula, elementum at pellentesque pellentesque, suscipit ac nunc. This is another footnoteEtiam lobortis, massa ac aliquam auctor, augue nisl sagittis urna, at dapibus tellus erat ullamcorper ligula. Praesent orci dui, pulvinar id convallis a, faucibus non mauris.


Footnote sample

Lorem ipsum dolor sit amet, [1] consectetur adipiscing elit. Nulla ac tellus nunc. Phasellus imperdiet leo metus, et gravida lacus. Donec metus ligula, elementum at pellentesque pellentesque, suscipit ac nunc. [2]Etiam lobortis, massa ac aliquam auctor, augue nisl sagittis urna, at dapibus tellus erat ullamcorper ligula. Praesent orci dui, pulvinar id convallis a, faucibus non mauris.



FOOTNOTES




(1) This is a footnote


(2) This is another footnote


  Appendix 2: What is new in the Footnote Manipulator tool?


  What is new in version 0.1.1.3?


Pop-up footnotes have been implemented using the ‹aside› element


  What is new in version 0.1.1.2?


Fixed error:

NameError: name 'ttk' is not defined

Error: name 'ttk' is not defined


  What is new in version 0.1.1.1?


	Bug fixed: HyperlinkID was used as the Footnote Class






  What is new in version 0.1.1.0?


  


  	An image for the plugin that can be included in the toolbar has been added (thanks to BeckyEbook).



  	You can include the epub:type="footnote" in footnotes and you can include epub:type="noteref" in hyperlinks.



  	You can specify the names for classes, hyperlinks and IDs that are associated with footnotes.



  	You can set the time interval between reminders for installing an update when an update becomes available.


  	Bug fixed: The previous version looked for updates and froze if an update was found.



  	Bug fixed: When reinstating footnotes an extra space was introduced into the beginning of the reinstated footnote.
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